
Back-In-Time

USER HANDBOOK

Your Serial Number: . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .



	 Licensing and Copyright Agreement

This software is Copyright ©2008 TED and ©TRI-EDRE.

Except as permitted under copyright law, no part of the program or this manual may be 
reproduced or distributed in any form or by any means without the prior written permission 
of TRI-EDRE.
The program, and this manual, are licensed only for individual use on a single computer. you 
are permitted by law to make working copies of the software program, solely for your own 
use. No copy (original or working) may be used while any other copy is in use.
If you ever sell, lend or give away the original copy of this Software program, all working 
copies must also be sold, lent or given to the same person, or destroyed.

	 Limited Warranty
TRI-EDRE warrants to you that the Software will perform substantially in accordance with the 
Documentation for the ninety (90) day period following the date of delivery of the Software 
to you. If the Software fails to meet the specifications of the warranty set forth above, TRI-
EDRE liability and your exclusive remedy will be replacement of the CD or a reasonable effort 
to make the product meet the above warranty specification. Except for the above express 
limited warranties, TRI-EDRE makes and you receive no warranties or conditions, express, 
implied, statutory or in any communication with you, and specifically disclaims any implied 
warranty of non infringement, merchantability or fitness for a particular purpose. TRI-EDRE 
does not warrant that the operation of the program will be uninterrupted or error free.
In no event will TRI-EDRE be liable for any loss of use, loss of profits, interruption of busi-
ness, or indirect, special, incidental or consequential damages of any kind, however caused 
and under any head of liability, arising out of use of or in connection with the software.

	 Trademarks
Back-In-Time is a trademark of TRI-EDRE.
All other products are trademarks of their respective companies.

©TRI-EDRE. All Rights Reserved.

TRI-EDRE
22 Place de l’Eglise - BP 111
83510 LORGUES (FRANCE)
Phone: +33 4 98 10 10 50

Fax: +33 4 98 10 10 55
Web site: www.tri-edre.fr • www.tri-edre.com

Email address: contact@tri-edre.fr • contact@tri-edre.com



	 Back-In-Time User Handbook	 3

Table of Content
Introduction............................................................................................................ 5

Welcome!.................................................................................................................... 5
Thank you for registering............................................................................................... 5
Latest version of the software........................................................................................ 5
Program Set-up............................................................................................................ 5
Uninstalling the Software............................................................................................... 5
Launching and Registering the Software.......................................................................... 5
Trial version................................................................................................................. 6
Technical support......................................................................................................... 6
Contacts...................................................................................................................... 6

Basics.................................................................................................................... 7
Time Machine.............................................................................................................. 7
Back-In-Time Contribution............................................................................................. 7

Preferences............................................................................................................ 8
Main Window.......................................................................................................... 9

Time Machine Status.................................................................................................... 9
Available Time Machine Data....................................................................................... 10
Information Window.................................................................................................... 11
Time Machine data related to a given folder.................................................................. 12
Restoring Time Machine.............................................................................................. 12

Back-In-Time Browser........................................................................................... 13
The Backup Selection................................................................................................. 14
The Contents List....................................................................................................... 14
Preview..................................................................................................................... 15
Information Dialog...................................................................................................... 16
The Display Options.................................................................................................... 16
Drag and drop restore................................................................................................. 16
Restoration................................................................................................................ 16

Browser Features.................................................................................................. 17
Open a sub-folder....................................................................................................... 17
Drag and Drop Copy................................................................................................... 17
Open with a drag and drop.......................................................................................... 18

Back-In-Time Restoration...................................................................................... 19
The Destination Location............................................................................................. 19

Other Features...................................................................................................... 21
List of items backed up............................................................................................... 21
Delete Time Machine data........................................................................................... 22

F.A.Q.................................................................................................................... 24



4	 Back-In-Time User Handbook



	 Back-In-Time User Handbook	 5

Introduction

Welcome!
Thank you for purchasing Back-In-Time!
Back-In-Time is the indispensable Time Machine companion for Macintosh to assist 
you in:

•	 Easily restore your data.
•	 Copy and restore Time Machine data to anywhere on your Mac, by drag and drop 
as well as with the build-in restore function of Back-In-Time.

•	 Copy data saved by Time Machine on other disks or Macs.

Thank you for registering
You will find a registration card for your software license enclosed in the package. Please 
complete the form and send it promptly. Once you are registered, you will have access 
to technical support and will be notified of updates and news about our products.

Latest version of the software
Check our web site “http://www.tri-edre.com” to know if you have the latest version of 
this software. If you do not have the latest version of Back-In-Time, download it from 
the web site using your serial number.

Note: serial numbers are compatible with all versions having the same main version 
number: a serial number of version 1.0 is useable with versions 1.1, 1.2, etc.

Note: Back-In-Time can detect new versions, and download the latest version.

Program Set-up
On the CD, or in the disk image that you downloaded, you will find the application 
«Back-In-Time». Drag this application into the Applications folder of your start-up 
disk.

Uninstalling the Software
To entirely remove this software from your hard disk, move Back-In-Time to the Trash, 
and delete the ~/Library/Application Support/Back-In-Time 1 folder.

Launching and Registering the Software
Double-click the application icon to run Back-In-Time. When first launching, you will 
be prompted to enter the Administrator password (the password required for any System 
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update). Then a dialog asks for your serial number (sent to you by email, or on a sticker 
on your CD).
This serial number will activate all of the features of Back-In-Time.
Please, keep this serial number in a safe place (for upgrades and technical support).

Trial version
If your version is not registered, you are automatically proposed to enter a serial number 
at launch. To use the trial version, just wait until the Demo button is active.
Trial version is fully useable, but is limited to the restoration and copy of the data from 
the last Time Machine backup.
You can enter a serial number at any time in the About box (accessed by the Back-In-
Time menu).

Technical support
First, please have a look at this manual, and our web site.
If you don’t find an answer to your question, our technical support can be accessed by 
e-mail, fax or phone.
Please have your serial number and the software version number ready before calling.

Contacts
If you have comments about this product, problems or questions about this user guide or 
with our web site – or if you are interested in a site license – please contact TRI-EDRE 
(specify the version and serial numbers of your copy):

by e-mail address:
contact@tri-edre.com
support@tri-edre.com

by phone or fax:
Phone: +33 4 98 10 10 50
Fax: +33 4 98 10 10 55

by mail:
TRI-EDRE

22 Place de l’Eglise - BP 111
83510 Lorgues (France)

Web site:
http://www.tri-edre.fr
http://www.tri-edre.com
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Basics

Time Machine
Time Machine is the backup tool integrated in Mac OS X. Time Machine automatically 
and periodically execute a copy of your disk(s) to a dedicated disk, internal or external, 
or remote - for example in a Time Capsule or AirPort device.
Time Machine provides a restoration function, but which has limited possibilities.

Back-In-Time Contribution
Back-In-Time is a restoration utility for Time Machine data, created to widely extend 
the restoration possibilities of Time Machine.
Back-In-Time is dedicated to restore, copy and recover your data backed up by Time 
Machine. Back-In-Time analyzes the contents of Time Machine data and offers 
possibilities that are impossible to realize with Time Machine :

•	 Drag and drop copy and restoration, to the original location as well as anywhere 
else in your Mac.

•	 An efficient visualization of your backup and available data: Shows the number of 
different available versions of any document, items that have been deleted, but of 
which Time Machine saved a version, etc.

•	 A powerful time and space browsing inside the backup of your data.
•	 The ability to recover Time Machine data created on other disks or with another 
Mac.

•	 The ability to have the list of all the items that were backed up during a specific 
Time Machine backup.

•	 And much more.
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Preferences

Select Preferences in the Back-In-Time menu.

Updates

You can set how Back-In-Time handles the updates.
Automatic Mount

If your Time Machine disk is not mounted (for example if you use Time Capsule), put 
an alias of this disk and it will be mounted automatically when you launch Back-In-
Time.
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Main Window

The main window is displayed when you launch Back-In-Time.

Time Machine Status
This area shows the Time Machine status.
Time Machine Activated: When Time Machine is activated, it can at any time start 
a backup, and modify the data that Back-In-Time uses. This is generally not a 
problem for punctual operations, but if you plan to restore an entire disk, or want 
to copy a large amount of data, it is advised to stop Time Machine during this 
operation.
Back-In-Time also shows the number of disks containing Time Machine data that were 
detected.

In the example above, the user has changed the Time Machine disks (for a bigger 
one), but has always the old disk mounted, with the data of the previous Time Machine 
backup. Back-In-Time will be able to recover data from the backup contained in the new 
disk, and also from those of the old disk.
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Available Time Machine Data
Time Machine backup your data to a disk. If this disk is mounted, Back-In-Time 
automatically analyzes its contents, and adds the data that are found in the list of 
available items. Back-In-Time finds in Time Machine backups all the data related to 
your internal disks (backed up by Time Machine), as well as other data saved in other 
Time Machine disks.
Generally, you’ll find in this list your Home, Documents, Desktop, and Applications 
folders, your start-up disk, and other predefined items for specific data (Mail, Address 
Book, iTunes, etc.).

Note: Only the items that have related data in the Time Machine disks) are displayed 
in the list.

Important: If Time Machine is set to use a remote disk (Time Capsule, etc.), you 
need to mount this disk in order for Back-In-Time to use it. Mount the volume, and 
then open the disk image (type .sparsebundle).

If Back-In-Time detects that several disks contain backup related to your data, these 
disks are shown in the items list (like in the example below, the disks «TM Backup» 
and «TM Backup 750 Go»), and the data of these disks are both used for restoration 
and browsing.

Note: This can be very useful when changing the Time Machine disk. In this case, Time 
Machine forgot all about the data backed up in the previous disk, starting from ground 
with the new one. Back-In-Time can search and recover data in the old disk (if already 
mounted) as well as the new one.

If Back-In-Time detects other Time Machine disks, their Time Machine data will be 
added in the list.

At the end of the list, you’ll find the recent items.
Refresh the list in Back-In-Time with the button just on the top of the list.
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Information Window
You open this window via the Window menu (Cmd-I), or with the Information button.

At the top of the window, you’ll find the status of Time Machine.
Then, the disk(s) containing Time Machine data. They are displayed in a pop-up menu. 
The machine(s) that are backed up in the selected disk are displayed in the other pop-up 
menu.
Select the desired disk and machine to show the related information (size, number of 
backups, etc.).

The list gives information about each backup done by Time Machine on the selected 
disk and machine, including the amount of data that were backed up.

Note: The amount of data is for all the disks backed up in the selected machine.

At the bottom of the list, the button access the function that displays all items that were 
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backed up during a specific Time Machine backup.

Time Machine data related to a given folder
A browser is available on the right part of the window, to discover the data corresponding 
to a given folder or file, browse through it and copy/restore old versions of files and 
folders.
You can access the browser using one of these ways:

• Select one of the items in the list.
• Or drag and drop a folder on the Back-In-Time window (or the icon in the Dock).
• Or choose the Open item in the File menu (Cmd-O).

Restoring Time Machine
You can restore a file or a folder with a drag and drop, or with the «Copy selection» 
button.
You can also directly restore the contents of a folder or a disk as it was at a given time.
Select one of the items in the list, and click the «Restore/Copy All» button, or choose 
the Restore item in the File menu.
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Back-In-Time Browser

You access the Back-In-Time browser by selecting an item of the left list, or with the 
Open function in the File menu, or if you drag and drop a volume, a folder or a file either 
on the Back-In-Time icon, or on its window.

Back-In-Time scans the disk(s) containing Time Machine data to rebuild the contents 
from the Time Machine backups. The data found in Time Machine related to the selected 
item are displayed in a list.
On the top, you can select the date of the reference backup, using the slider (by default, 
the latest backup is displayed). The list shows the contents as it was at this date.
On the top right, you can show/hide the information drawer. On the center, the lists 
shows the contents. On the bottom, there are the Copy buttons.

Show and Hide the information drawer

Click the triangle on top right to show or hide the information drawer. In the drawer, 
information about the selected item is displayed.
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The Backup Selection
On the top of the window, you’ll find settings and information about the different backup 
that Back-In-Time has detected for the data to analyze.

They are the backup executed by Time Machine, represented by their date of execution. 
The backup date is selected with the cursor, and the calendar shows this date.
The total number of backups is displayed on the left top of the slider (23 backups in the 
example above). The oldest and latest dates of backup are displayed under the slider.
You can change the date of the backup that is the reference for the representation of the 
contents as well as for the restoration.
The reference backup can be selected either by the pop-up menu (on the left of the 
slider), by the slider, or the up and down buttons on the right.

The slider shows the progress of the analysis when searching for the data inside the 
Time Machine backup. The current backup is represented by a red index (progressing 
from the last backup to the older).

If you move the mouse over the slider, the date of the corresponding backup is 
displayed.

The Contents List
The list shows the contents of the analyzed folder. Click the triangle on the left to reveal 
the contents of folders, or the different available versions of documents.
Back-In-Time shows the documents having multiple versions available in the Time 
Machine backup, until the reference backup date, with the number of versions (in a red 
circle, on the right of the line).
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By opening the versions list (by the triangle on the left), Back-In-Time shows each 
version of the document, with their size and date.
The slider shows information about the selected item in the list. For each backup, you 
can easily see if the item exists or not (the area is light blue if the item does not exist in 
a given backup), and if a backup contains a new version (red) or a version that was not 
modified (yellow).

Deleted items (that do not exist in the selected backup, but having a version in an older 
backup) are displayed with a gray background, and a Trash icon.

In this case, the slider shows the backup where this item can be found. Move the mouse 
over the indicator to display the date of the backup containing this item.

If you select an item in the list, its backup date is shown in the information drawer.
Refresh the contents of the list

Click the button on the top right of the list to refresh its contents.

Preview
You can preview any document and any of its versions. Select the item and press the 
space bar to view its contents (or use the Browser menu, or the contextual menu).
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Information Dialog
You can display a dialog with information about any document and any of its versions. 
Select the item and use the Browser menu (Cmd-I), or the contextual menu.

The Display Options
In the drawer, you have checkboxes to choose to display:

• Invisible items. They are displayed with a yellow background.
• Deleted items: If checked, items hat are not available in the selected backup, but 
exist in an older backup are displayed with a gray background, and a trash icon 
on the right.

• Package and Bundle contents: If checked, the contents of the applications and 
other bundles is displayed.

Drag and drop restore
To copy or restore a folder, a document or one of the available versions, drag and drop 
it to the desired location (the Desktop or any available folder or disk).
You can copy any available file or folder, even versions of previous backup, or items 
that were deleted, from an older version.

Restoration
You can also restore the entire folder, or a selection of items, by clicking one of the 
buttons at the bottom of the window.
Before, you can choose the date of the backup that will be used to restore the correct 
data.
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Browser Features

You can access browser tools via the Browser menu (certain functions are available 
with the contextual menu).

First group change the display options (Invisible and deleted items, and bundle 
contents).
Some functions are available for the selected item:

•	 Preview (Quick Look), that you can also obtain with the space bar.
•	 Information (shows the information dialog).
•	 Reveal in Finder.
•	 Open (with the default application).
•	 Copy (with the copy/restore function).
•	 Delete (from the Time Machine backup).

The other functions of this menu allows to navigate in the backups with the shortcuts.

Open a sub-folder
You open and display the contents of a folder in the list by clicking the triangle.
You can also double-click a folder to open it in the browser.

Drag and Drop Copy
Drag and drop an item to copy it at the desired location in the Finder (Desktop, 
folder).
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Open with a drag and drop
A document can be dragged and dropped on an application’s icon to open it with this 
application.

Note: If you modify this document, you cannot save it at its current location. You will 
need to save it in another location.
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Back-In-Time Restoration

This is the window where you can launch a restoration, either from a selection of files 
or folders, or for an entire folder or disk.

What is restored?

The top area of the window shows the items to be restored, as selected from the previous 
step.
You choose the date of the backup that will be restored. The available dates are those 
that Back-In-Time detected in the disk where Time Machine did its backup.

The data will be restored as they were at the given date.

The Destination Location
You have to choose where the restoration will copy the files ad folders. It can be either 
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the original location, or any location in one of the available disks.
Caution! Items that were not in the backup at this date will be removed in the 
destination (if they exist there). Items that are different (newer as well as older) will 
be replaced. Items that were not modified will not be copied again.

If you restore items at their original location, you can choose not to delete the existing 
data, but to preserve them. They will be renamed, adding a suffix to the name.
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Other Features

List of items backed up
Back-In-Time can show all the items that were backed up during a specific Time Machine 
backup. You can search inside the data of an entire disk, as well as those of a folder.
To execute a search:

•	 For a disk of a specific backup, open the Time Machine Data information window, 
select a backup in the list, and click the button at the bottom of the window.

•	 You can also, in the Back-In-Time browser, select an item in the left list or open a 
folder. Then, choose the item «Show Items Backed Up» in the File menu.

The settings dialog is displayed.
•	 Choose the date of the backup to scan in the pop-up menu.
•	 Choose the mode: either the search of items backed up during a particular backup, 
or a comparison between two backups.

Once your settings correct, launch the search.
Note: The scan procedure can be long. You can interrupt it at any time, or skip the folder 
that is currently analyzed.

Back-In-Time shows the found items as a hierarchical list. Only the items that were 
backed up during the backup are displayed.
On the right of each folder, the number of files and the size is displayed in red, as well 
as the size of the files.
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You can restart a new search by clicking the Search... button.

Delete Time Machine data
Back-In-Time provides a powerful function to delete data in the Time Machine backups 
disk.
You can delete a single version of a file in a particular backup (without changing the 
other backups of this file), but you can also delete all the versions of a selection of files 
and folders in all Time Machine backups.
You have here a very easy way to clean the Time Machine disk, by removing data that 
were backed up but that you do not need any more. It’s also an easy way to free space 
in the Time Machine disk.
CAUTION! Removing data from the Time Machine disk is irreversible. Be very 
careful when you use this function.

Note: Data are remove only from the Time Machine disk. Original items in your hard disk 
are not deleted by this function.

To delete data, select the files and folders to remove in the browser, and choose 
the Remove function in the Browser menu (or in the contextual menu). A dialog is 
displayed:
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You can choose to delete:
•	 A single version only: delete the sole version located in the current backup.
Note: If no version is in the current backup (item shown with a Trash icon), the version 
displayed in the list will be removed (this version is in a previous backup).
•	 All versions: delete all the versions of the selected item, in the current Time 
Machine backup as well as in all older Time Machine backups.

Note: If the current backup is the last one done by Time Machine, all versions of the 
selected files and folders will be removed from the Time Machine data.
•	 In a set of backups: delete all the versions of the selected items in a set of Time 
Machine backups, from the current backup to the backup designed by its date in 
the pop-up menu.

Note: If you remove all the backups of a file that is still present on your main hard disk, 
the file will be backed up again during the next Time Machine backup. You’ll see it again 
in Back-In-Time (but the last version only).
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F.A.Q

Q: Why do I get a message stating that Time Machine data is not available?
R: When analyzing the Time Machine data related to a given folder or disk, Back-In-
Time will search within the mounted disks used by Time Machine if such data exist.
If the folder that you attempt to analyze was not backed up by Time Machine (either 
because it was excluded, or because it is located in a volume that is not backed up), 
you’ll have such a message.
Also, if Time Machine works with a remote disk (Time Capsule, etc.), you need to 
mount this disk, and then open the disk image used by Time Machine.
Q: Why do Back-In-Time advise me to deactivate Time Machine during 
restoration?
R: When Time Machine is active and is running a backup, it will modify its data, adding 
items and removing others. If you copy a file or folder by drag and drop, this will not be 
generally a problem. But if you plan to restore an entire disk or a large amount of data, 
it is better to stop Time Machine during this operation.
Q: I changed the Time Machine disk to a larger one. Is it possible with Back-In-
Time to recover data saved in the old disk?
R: Yes. Back-In-Time searches in all mounted disks containing Time Machine data, and 
presents both old and new disk contents. You can recover and copy data from the old 
disk as well as the new one.
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